Working with Authority Records

To work with authority records, you must have one of the following roles:

- Cataloger
- Catalog Manager
- Catalog Administrator
- Repository Manager
- Physical Inventory Operator
- Purchase Operator
- Purchase Manager
- Editor Full (not functional)
- Digital Inventory Operator

Authority Vocabularies in the Community Zone

Alma provides a set of authority records that are updated and maintained regularly by Ex Libris in the Community Zone. Alma maintains the following vocabularies:

<table>
<thead>
<tr>
<th>Authority Vocabulary</th>
<th>Subject/Name Authority</th>
<th>Update Frequency</th>
<th>Vocabulary Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>BARE (Norwegian Authority System) – BIBSYS Authority Registry</td>
<td>Subject and Name</td>
<td>Daily</td>
<td>BARE</td>
</tr>
<tr>
<td>(See <a href="#">Working with Norwegian Authority System (BARE) Records</a> for more information.)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BK Basisklassifikation Classification</td>
<td>Subject and Name</td>
<td>When available</td>
<td>BKL</td>
</tr>
<tr>
<td>BNC - Catàleg d’autoritats de noms i títols de Catalunya (CANTIC)</td>
<td>Subject and Name</td>
<td>When available</td>
<td>CANTIC</td>
</tr>
<tr>
<td>BNC - Llista d’encapçalaments de matèria en català (Lemac)</td>
<td>Subject</td>
<td>When available</td>
<td>LEMAC</td>
</tr>
<tr>
<td>BNF – Bibliothèque nationale de France - MARC 21 Version</td>
<td>Subject and Name</td>
<td>Monthly</td>
<td>FRBNF</td>
</tr>
<tr>
<td>Canadiana Name Authorities in French</td>
<td>Name</td>
<td>Every 2 weeks</td>
<td>LACNAF</td>
</tr>
<tr>
<td>Cataleg d’autoritats del CCUC</td>
<td>Subject and Name</td>
<td>When available</td>
<td>CCUC</td>
</tr>
<tr>
<td>CSIC</td>
<td>Subject and Name</td>
<td>Daily</td>
<td>CSICAU</td>
</tr>
<tr>
<td>Czech National Authority Database / Databáze národních autorit</td>
<td>Subject and Name</td>
<td>Every 6 hours</td>
<td>CZENAS</td>
</tr>
<tr>
<td>Authority Vocabulary</td>
<td>Subject/Name Authority</td>
<td>Update Frequency</td>
<td>Vocabulary Code</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>------------------------</td>
<td>--------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>EuroVoc – the EU's multilingual thesaurus</td>
<td>Subject</td>
<td>When available</td>
<td>EUROVOC</td>
</tr>
<tr>
<td>FAST – Faceted Application of Subject Terminology – OCLC</td>
<td>Subject</td>
<td>When available</td>
<td>FAST</td>
</tr>
<tr>
<td>Finnish Genre and Form Vocabulary (Finnish)</td>
<td>Subject</td>
<td>Weekly</td>
<td>SLM/FIN</td>
</tr>
<tr>
<td>Finnish Genre and Form Vocabulary (Swedish)</td>
<td>Subject</td>
<td>Weekly</td>
<td>SLM/SWE</td>
</tr>
<tr>
<td>Finnish Name Authority File</td>
<td>Name</td>
<td>Every 6 hours</td>
<td>FINAF</td>
</tr>
<tr>
<td>French MeSH UNIMARC Version</td>
<td>Subject</td>
<td>When available</td>
<td>FMESH</td>
</tr>
<tr>
<td>General Finnish Ontology (Finnish)</td>
<td>Subject</td>
<td>Weekly</td>
<td>YSO/FIN</td>
</tr>
<tr>
<td>General Finnish Ontology (Swedish)</td>
<td>Subject</td>
<td>Weekly</td>
<td>YSO/SWE</td>
</tr>
<tr>
<td>GND – German National Library</td>
<td>Subject and Name</td>
<td>Daily</td>
<td>GND</td>
</tr>
<tr>
<td>GSAFD Genre Terms</td>
<td>Subject</td>
<td>When available</td>
<td>GSAFD</td>
</tr>
<tr>
<td>Haifa Children Library Subjects</td>
<td>Subject</td>
<td>When available</td>
<td>HAIFACH</td>
</tr>
<tr>
<td>Hong Kong Chinese Authority Name</td>
<td>Subject and Name</td>
<td>Daily</td>
<td>HKCAN</td>
</tr>
<tr>
<td>IdRef - Version MARC21</td>
<td>Subject and Name</td>
<td>Every 6 hours</td>
<td>IDREF</td>
</tr>
<tr>
<td>IdRef – Version UNIMARC</td>
<td>Subject and Name</td>
<td>Every 6 hours</td>
<td>RAMEAU</td>
</tr>
<tr>
<td>Jurivoc</td>
<td>Subject</td>
<td>When available</td>
<td>JURIVOC</td>
</tr>
<tr>
<td>LCDGT (Library of Congress Demographic Group Terms)</td>
<td>Subject</td>
<td>When available</td>
<td>LCDGT</td>
</tr>
<tr>
<td>Library and Archives Canada (LAC) – Canadian Subject Headings</td>
<td>Subject</td>
<td>When available</td>
<td>CSH</td>
</tr>
<tr>
<td>Library of Congress Children's Subject Heading</td>
<td>Subject</td>
<td>When available</td>
<td>LCSHKIDS</td>
</tr>
<tr>
<td>Library of Congress (LoC) – Genre/Form Terms Thesaurus Records</td>
<td>Subject</td>
<td>Weekly</td>
<td>LCGFT</td>
</tr>
<tr>
<td>Library of Congress (LoC) – Medium of Performance Thesaurus for Music</td>
<td>Subject</td>
<td>When available</td>
<td>LCMPT</td>
</tr>
<tr>
<td>Library of Congress Name (LCNAF)</td>
<td>Name</td>
<td>Weekly</td>
<td>LCNAMES</td>
</tr>
<tr>
<td>Library of Congress Subject (LCSH)</td>
<td>Subject</td>
<td>Weekly</td>
<td>LCSH</td>
</tr>
<tr>
<td>List of Chinese Subject Terms</td>
<td>Subject</td>
<td>Quarterly</td>
<td>LCSTTT</td>
</tr>
<tr>
<td>Maori Subject Headings</td>
<td>Subject</td>
<td>3 times a year</td>
<td>REO</td>
</tr>
<tr>
<td>National Agricultural Library subject authority file</td>
<td>Subject (English Terms)</td>
<td>Annually</td>
<td>NAL</td>
</tr>
<tr>
<td>National Library of Israel – Multilingual Thesaurus</td>
<td>Subject and Name</td>
<td>Every 6 hours</td>
<td>NLI</td>
</tr>
<tr>
<td>National Library of Spain</td>
<td>Subject and Name</td>
<td>When available</td>
<td>EMBNE</td>
</tr>
</tbody>
</table>
### Authority Vocabulary

<table>
<thead>
<tr>
<th>Authority Vocabulary</th>
<th>Subject/Name Authority</th>
<th>Update Frequency</th>
<th>Vocabulary Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>New classification scheme for Chinese libraries</td>
<td>Classification</td>
<td>Quarterly</td>
<td>NCSCLT</td>
</tr>
<tr>
<td>NLM MeSH – United States National Library of Medicine</td>
<td>Subject</td>
<td>Annually</td>
<td>MESH</td>
</tr>
<tr>
<td>NUKAT</td>
<td>Subject and Name</td>
<td>Daily</td>
<td>NUKAT</td>
</tr>
<tr>
<td>Nuovo Soggettario</td>
<td>Subject</td>
<td>Twice a year</td>
<td>NSBNCF</td>
</tr>
<tr>
<td>PUC – Pontificia Universidad Católica de Chile</td>
<td>Subject and Name</td>
<td>When available</td>
<td>CLSAPUC</td>
</tr>
<tr>
<td>RAMEAU – MARC 21 Version</td>
<td>Subject</td>
<td>Monthly</td>
<td>RAM</td>
</tr>
<tr>
<td>RVK Classification</td>
<td>Subject and Name</td>
<td>Twice a year</td>
<td>RVK</td>
</tr>
<tr>
<td>(See <a href="#">Working with the RVK Authority Record Classification</a> for more information.)</td>
<td>Subject and Name</td>
<td>Twice a year</td>
<td>RVK</td>
</tr>
<tr>
<td>Taiwan Name Authority File</td>
<td>Subject and Name</td>
<td>Weekly</td>
<td>TWNAF</td>
</tr>
</tbody>
</table>

#### Note

To use several types of names authorities, you must request Ex Libris to configure authority priorities for your system (supported only for non-multilingual authorities). If you do not do that, then multiple subject authorities can be used by Alma, but only one type of names authority can be used. For example, if Alma is defined to use LCNAMES, it cannot also use GND names authorities.

If local authorities are enabled for your institution (a task that needs to be completed by Ex Libris), you can create local authority records, which override the global authority records provided with Alma in the Community Zone. For more information, refer to [Creating Local Authority Records](#).

Each time a bibliographic record is saved, the authority headings linked to it are re-calculated.

### Jobs Related to Authority Records

#### Note

To search Alma and Primo VE by non-preferred terms, the parameter enable_extender_index_linked-aut at Configuration > Resources > General > Other Settings must be set to true. For more information, see [Non-Preferred Terms in Repository Search](#).

Alma runs the following jobs automatically every day to authorize the bibliographic records in your catalog:

- **Authorities - Link BIB Headings** – This job searches all authority (and local authority, if enabled by Ex Libris Support) record fields, including subdivision fields, for complete terms listed in bibliographic records (giving priority to local authorities, if enabled). If exact matches are found, the bibliographic records are linked to the corresponding authority records. If exact matches are not found, a search of all authority records is performed once again but the subdivision fields are disregarded, and the bibliographic records are linked to the matching authority records that are located during the second search. On a subsequent run of the **Authorities – Link BIB Headings** job, a bibliographic record
that was linked to an authority record without subdivision fields may be re-linked to a better matching authority record (with subdivision fields). If a match is found on the main part of the heading, the subdivisions are still retained in the bib record. For MARC 21, partial matching for subdivisions is done on $v x y z$ in 6XX fields. For UNIMARC and CNMARC, partial matching for subdivisions is done on $x, y, z$ on fields 410, 600, 601, 602, 605, 606, 607, 610, 616, 617, 620, 675, 680, 711, 713, 730, 740, 741, 742.

---

**Note**

Over time, you may have local authority records that you’ve created that subsequently become available as Community Zone authority records. When these records are added to the Community Zone, nothing happens to the records attached to your local authority records. The local authority records will still be local without any connection to the Community Zone. A bibliographic record that is already linked to your local authority record will not have its link switched to the Community Zone authority record.

However, when the authority records that are the same as your local authority records are added to the Community Zone, you can choose to delete the local authority records. If you choose to delete the local authority records, all the headings will be linked to the Community Zone authority record with the same preferred term (1XX field) by Alma’s nightly linking job.

---

For CJK content, bibliographic records are linked to authority records based on CJK content (not transliterated Latin content).

- **Authorities - Preferred Term Correction** – This job performs preferred term correction on all bibliographic records that are linked to authority records using the **Authorities - Link BIB Headings** job. For example, if a bibliographic record contains the non-preferred term “Narcotics, Control of,” and the associated authority record contains the preferred term “Drug control,” the Authorities – Preferred Term Correction job replaces “Narcotics, Control of” with the preferred term “Drug control.” Bibliographic records are also updated with any subsequent updates to authority records. If there were any failed records in the job's run, the job handles them in its next run.

This job is disabled by default. To enable it, set the `disable_preferred_term_correction_job` parameter (see [Configuring Other Settings (Resource Management)](https://www.exlibrisgroup.com)) to `false`. Subsequently, view the Scheduled tab of the Monitor Jobs page (see [Viewing Scheduled Jobs](https://www.exlibrisgroup.com)) and confirm that the **Authorities - Preferred Term Correction** job is active.

The **Authorities - Preferred Term Correction** job does not handle preferred term correction on migrated bibliographic records retroactively. Since migrated bibliographic records may be linked to authorities in Alma, any change (to the bibliographic record authorized fields, or to the authority record in the Community Zone to which the bibliographic record is linked) that occurs in Alma after the record is initially migrated, triggers future preferred term corrections on the records after the **Authorities - Preferred Term Correction** job is enabled.

For a list of punctuation rules that are implemented when bibliographic records are updated from the authority database, refer to [Implemented Punctuation Rules for Updated Bibliographic Records](https://www.exlibrisgroup.com).

---

**Alma-Based Authority Management**

Alma supports Alma-based authority management. For an institution that manages local authority records and publishes them to the Community Zone, there is the option to have the Alma community contribute to these authority records (like the National Library of Israel (NLI) implementation). If you are an institution that 1) currently manages an authority file locally, 2) publishes it to the Community Zone, and 3) wants to have other authorized members of the Alma community contribute changes to this authority file, contact Ex Libris to analyze the feasibility of your request. If your authority requirements match the criteria for this functionality, Ex Libris will work with you to implement this capability. See [Working with NLI](https://www.exlibrisgroup.com).
Adding a Local Authority Definition

In Alma, you can create local authorities (or vocabularies) to use when entering authority records with the MD Editor or importing authority records using an import profile.

**Note**

- In order to use local authorities in Alma, an Ex Libris representative must enable the local authority functionality for your institution.

- Unless you have configured authority priorities for your system (see Resource Management - November 2016 Enhancements for information on this feature), multiple subject authorities can be used by Alma, but only one type of names authority can be used (global or local). For example, if Alma is defined to use LCNAMES, it cannot also use GND names authorities.

However, if Alma is defined to use LCNAMES, you can also maintain a local LCNAMES authority and use it. But you cannot use a local authority that is not LCNAMES. In this case, only one type is being used both as a local and a global authority.

Given these considerations, you should define only one type of Name or Names and Subjects local vocabulary.

For information on the code to be used for the defined names authority, see the Code entry in the Add Local Authority dialog box below.

**To create a local authority:**

**Note**

Note that when you add a local authority configuration, if you want to use the functionality provided by the Language Configuration option, you first need to contact Support to configure that capability for your system.

1. On the Metadata Configuration List page (Configuration Menu > Resources > Cataloging > Metadata Configuration), select Add Local Authority. The Add Local Authority dialog box appears.
2. Complete the information in the Add Local Authority dialog box (see the table below for more information).

<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name to identify this local authority. This name appears in the Vocabulary Name column.</td>
</tr>
<tr>
<td>Code</td>
<td>Enter an identifying code for this local authority that appears in the Code column in the Authority Vocabularies section on the Metadata Configuration List page and the Vocabulary code drop-down list on the Import Profile Details page for</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>authority profiles.</strong>&lt;br&gt;If the authority indication is in the bibliographic record's second indicator 7, subfield 2, the code must match what is in this subfield 2. This is relevant for <strong>Subject</strong> and <strong>Names and Subjects</strong> types of local authorities.&lt;br&gt;&lt;br&gt;For the <strong>Name</strong> type of local authority (see the note above, at the beginning of this section), the code must match the <code>authority_names</code> customer parameter value that was entered for your institution by Ex Libris staff. If you are unsure of the defined value for this parameter (the default for which is <code>LCNAMES</code>), contact an Ex Libris representative.</td>
<td></td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Select from the following options available in the drop-down list:&lt;br&gt;- Subject&lt;br&gt;- Name&lt;br&gt;- Names and subjects&lt;br&gt;- Classification</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>No more than one name type of local vocabulary should be created.</td>
</tr>
<tr>
<td><strong>Direct ID Prefix</strong></td>
<td>Enter one or more prefixes in this field to be used for bibliographic to authority record matching and linking when there are multiple $0 entries (or $3 in UNIMARC or CNMARC records). For more information, see Authority Control Based on Multiple Authority Identifiers in a Bibliographic Record and Using Originating System IDs for Linking Bibliographic Records to Authority Records.&lt;br&gt;&lt;br&gt;The prefix must be entered with parentheses surrounding it. If more than one prefix is required, separate them by commas. For example: (CCL1),(CCL2),(CCL3). Notice that there are no spaces separating these entries. The maximum number of characters for this field is 255. The sequence in which you enter the prefixes determines the priority order in which they are evaluated for a match when there are multiple 035 entries in the authority record to match against.&lt;br&gt;&lt;br&gt;For Community Zone managed authority records, the <strong>Direct ID Prefix</strong> needs to be configured by Ex Libris. For example, the DE-588 Direct Prefix ID used in the GND (German National Library Names and Subjects) records is configured at the Community Zone level.</td>
</tr>
<tr>
<td><strong>Family</strong></td>
<td>Select the cataloging standard (such as MARC 21, UNIMARC, or CNMARC) that you plan to use for entering the local authority records with this profile. This name displays in the <strong>Family</strong> column.</td>
</tr>
<tr>
<td><strong>Multilingual</strong></td>
<td>Select <strong>Yes</strong> from the drop-down list to indicate that the authority record may contain multiple language entries. See step 4 below for more information.&lt;br&gt;&lt;br&gt;For Community Zone managed authority records, the <strong>Multilingual</strong> parameter (and its associated components, Language Configuration and Allow multi preferred terms) needs to be configured by Ex Libris at the Community Zone level.&lt;br&gt;&lt;br&gt;See Working with Multilingual Authority Records for more information.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Use this option to more fully identify the local authority that you are creating.</td>
</tr>
</tbody>
</table>

3. Select **Add and Close**. The local authority configuration that you created appears in the Authority Vocabularies section of the Metadata Configuration List page.

4. (Optional) If you selected **Yes** for the **Multilingual** option above, select the **Edit** row action for the local vocabulary that you created in the steps above and complete configuring the local vocabulary using the information provided in the table below.
**Parameter** | **Description**
---|---

Language Configuration

**Note**
- This is only available for multilingual authorities.
- If you want to use the functionality provided by the Language Configuration option, you first need to contact Support to configure this capability for your system.

This button appears when you select Yes for the Multilingual parameter.

![Add local Authority](image)

**Language Configuration Button**

Select the Language Configuration button to open the Language Code mapping table.

This configuration defines all the possible languages that are defined in the authority records. With this mapping table, when no language is specified in $9 of the bibliographic record, the system looks for an authority heading with text that matches exactly to the text in the bibliographic field. The system will look for a match in each language in the order defined in the Order column of the configuration. See the example below.

In this example, if an exact text match is found in Chinese, the link is created between the bibliographic and authority record and $9 with the correct language is added when the preferred-term correction is done. If no Chinese text match is found, the system continues to look for an exact text match using the next language in numeric order as specified in the Order column of the mapping table. If no text match is found and the end of the list is reached, no link is made. Notice, in this example, that an empty Language Code setting in the mapping table is a valid option.

![Language Code Mapping Table](image)

**Language Code Mapping Table**

Select Add Row and enter Vocabulary Code, Language Name, Language Code, and Order. Note that the language code entries are free-text fields. Add these based on the codes that the authority file uses.

Select Add Row to add these settings to your Language Code mapping table.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vocabulary Code</td>
<td></td>
</tr>
<tr>
<td>Language Name</td>
<td></td>
</tr>
<tr>
<td>Language Code</td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>Add Row</td>
</tr>
</tbody>
</table>

**Add Row Options**

In addition to local authority records, this capability is also available for global authority records when Ex Libris configures the Multilingual parameter in the Community Zone.

**Note**

This feature is only relevant for multilingual authorities where the matching is done by text and not by ID.

See [Working with Multilingual Authority Records](#) for more information.

**Allow multi preferred terms**

This parameter appears when you select Yes for the Multilingual parameter.

- Use this option to set the record validation in Alma for accepting multilingual authority records with multiple preferred terms when the same language is identified in $9.

**Multiple Preferred Terms with the Same $9 (Authority Record)**

If Allow multi preferred terms is not selected, a warning or block validation occurs for multilingual authority records with multiple preferred terms and the same language is identified in $9.

See [Subfield 9 with the Same Language Code](#) for more information.

- Use this option to set the record validation in Alma for accepting multilingual authority records with multiple preferred terms when there is no $9 specified. With Allow multi preferred terms selected, the MARC 21 Auth validation on save process will allow records without $9 specified.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>See Working with Validation Exception Profiles for more information.</td>
<td></td>
</tr>
</tbody>
</table>

MARC 21 Auth validation on save Process

See No Subfield 9 Specified for more information.

See Working with Multilingual Authority Records for more information.

5. Select **Save**.

You can manually enter local authority records or import local authority records using the local authority profile that you configured (see Creating Local Authority Records for more information). The local authority definition that you created appears in the MD Editor File > New options menu and in the Import Profile Details **Vocabulary code** drop-down list.

### Creating Local Authority Records

You can create local authority records:

- Using the MD Editor (see Creating Local Authority Records Using the MD Editor)
- Using an import profile (see Managing Import Profiles)

**Note**

- To use local authorities in Alma, Ex Libris Support/your Ex Libris Professional Services representative must enable local authority functionality for your institution.
- To create a local authority record (either via the MD Editor or via an import profile) for authority vocabulary that exists in the Community Zone, you must first create this local authority (vocabulary) in your institution (if it does not already exist). For example, if the Community Zone has a defined authority (vocabulary) for REO, but is missing a specific authority record that you want to create locally, ensure that the local authority (vocabulary) for REO exists in your institution before you create the authority record locally. For information on creating local authorities (vocabulary), see Adding a Local Authority Definition.
- You can delete local authorities using the **Delete Local Authority Records** job – see Delete Local Authority Records.
- Unless you have configured authority priorities for your system (see Resource Management - November 2016 Enhancements for information on this feature), multiple subject authorities can be used by Alma, but only one type of names authority can be used. For example, if Alma is defined to use LCNAMES, it cannot also use GND names authorities. For more information, see Adding a Local Authority Definition.

### Creating Local Authority Records Using the MD Editor

When you want to create a single local authority record, you can use the MD Editor.
To create a local authority record:

1. Open the MD Editor.

2. Select **New** and select from the list of local vocabularies that have been created/implemented for your system (see Adding a Local Authority Definition or, if the local authority vocabulary is an extension of a global one, it appears here automatically as an option with no predefinition required), such as:
   - (local) Library of Congress Subject Headings
   - (local) Library of Congress name authority records
   - (local) U.S. National Library of Medicine, Medical Subject Headings 2013
   - (local) German National Library of Names and Subject Headings

   For members in a Network configured for creating local authority records, the **New** menu options display authorities with both the Institution and Network icons to distinguish where the record you are creating will be stored (at the Institution level or the Network level).

3. Choose a template (see Working with Record Templates) and enter the authority record data/terms.

4. Select **Save > Save and Release Record**.

   If the system identifies another record in the Alma repository with duplicate headings content, it presents a confirmation pop-up message. You need to select **Yes** or **No** to indicate how to handle the duplicate. If you select **Yes**, the duplicate information is presented for you to view and/or edit.

   ![Confirmation required](image)

   **Duplicate Handling Confirmation**

   After the record is saved, you can view the record you entered using an Authorities search. You can create a bibliographic record that uses the local authority record/terms that you created/saved. Preferred terms are marked with a star. (Note that if you select a non-preferred term, the MD Editor automatically populates the bibliographic record with the preferred term.)

---

**Viewing Authority Records**

From several locations in Alma, you can view read-only records on the simple Record View page. For more information see Viewing Read-Only Records in the Simple Record View Page.

---

**Exporting Local Authority Records**

Using saved sets, local authority records can be exported from Alma using the Export Authority Records job.

For more information regarding sets, see Managing Search Queries and Sets.
Changing the Placement of an Authority Record

While working in draft mode with an authority record, you can change the placement of the record to the Community Zone, Network Zone, or the Institution Zone. The options that you are provided when changing the placement of the authority record vary depending on how your Metadata configuration is set for locally managed or community managed authority records (see Controlling the Display and Access of Global Authorities in the MD Editor) and the vocabulary that you select when creating your draft record.

To change the placement of a draft authority record:

1. Open the MD Editor (Resource Management > Cataloging > Open Metadata Editor).
2. Select New and select the vocabulary name.
3. Enter the authority record details.
4. Select Record Actions > Change Authority Placement.
5. The New Authority Record Placement dialog box appears. The options provided vary depending on the vocabulary that you selected for your draft authority record (Local or Network) and how your Metadata configuration is set for locally-managed or community-managed authority records (see Controlling the Display and Access of Global Authorities in the MD Editor). One or more of the following options are provided:
   - Community Zone
   - Network (Zone)
   - Local (Institution Zone)
6. Select the placement location and select OK.

You may select the Change Authority Placement option and change the placement location, again. However, once you have saved the record, you can no longer change the placement. The Change Authority Placement option appears as disabled after the record has been saved.

Performing Global Changes on Locally Managed Authority Records

Alma supports making global changes to locally managed authorities. This capability is implemented using Drools-based normalization processes similar to the Alma capability available for bibliographic normalization jobs.

As a prerequisite, you need to create a normalization rule for the desired changes in the Metadata Editor (refer to Working with Normalization Rules for additional information).

To create the Drools-based processes for local authority normalization:

1. Open the Metadata List Configuration page (Configuration Menu > Cataloging section > Metadata Configuration).
2. Select the relevant profile. For example, for the local authority Metadata Configuration, select the MARC 21 Authority link. The Fields tab of the Profile Details page opens.

3. Select the Normalization Processes tab.


5. Enter the Name, Description, and Status.


7. Select Add Tasks, select the MARC Normalization Rules process, and select Add and Close.


9. From the Drools File Key dropdown list, select the normalization rule you have previously created in the Metadata Editor.

10. Select Save. The new normalization rule displays in the Normalization tab of the Profile Details page and can be edited, copied, or deleted using the Actions options.

To run a normalization job using the normalization rule/process you created:

- Run the normalization job you created above. For more information, see Running Manual Jobs on Defined Sets.

Managing Authority Records in the MD Editor

The MD Editor provides catalogers with quick navigation to the authority records (for preferred/nonpreferred headings) that are associated with a bibliographic record that is being edited using the Alma MD Editor. To quickly navigate to authority headings records, use F3 or the Alt+F3 key combination. These two options can be used interchangeably but present the information in a different manner. In general, wherever you see F3 referenced, you can also use Alt+F3. See Using F3 for more information.

For additional information about working with authority records, see:

- Linking an Authority Record to a Bibliographic Record
- Deriving an Authority Record from a Bibliographic Record
- Viewing Linked Names/Subject Headings from a Bibliographic Record

Authority Controlled Fields

The below are authority-controlled fields in a bibliographic record:
• 100 (besides $e,u,0-9 that are not used for authority linking), 110, 111, 130, 440, 490, 600, 610-611, 630, 647, 648, 650, 651, 654, 655, 700, 710, 730, 748, 751, 754, 800, 810-819, and 830.

Linking an Authority Record to a Bibliographic Record

The MD Editor allows you to quickly link to a suggested authority record from an authority-controlled field in a bibliographic record. It also enables you to view a read-only version of a suggested authority record and view the bibliographic records that are linked to this authority record.

In addition to the Name and Subject Headings authority support for the above bibliographic fields that are mapped to authority headings, Alma provides mapping for the bibliographic 490$a and 440$a (obsolete) and an F3 lookup for these fields in the Alma MD Editor. The 490$a (and 440$a) lookup is pulled from the authority record 130$a and 430$a:

• 130 – Main Entry – Uniform Title
• 630 – Subject Added Entry – Uniform Title
• 730 – Added Entry – Uniform Title
• 830 – Series Added Entry – Uniform Title

With the F3 lookup (refer to the procedure below for more information), you are provided the option to select your preferred series statement from a predefined list that is displayed in the MD Editor. The system does not do automatic linking/preferred term correction as part of the authorities daily processing for the 490$a/440$a, since the 490$a/440$a series statement represents the information (the way that a series is named) on the book itself. (Refer to http://id.loc.gov/authorities/names.html for more information.) However, you can do an F3 lookup in the MD Editor for the 490$a/440$a series statement and, optionally, Select the preferred authorities to update the bibliographic 490$a/440$a. Refer to the example below.

![Authority Record Linking Example](image-url)
Viewing and Linking to an Authority Record

To view/link to an authority record from an authority-controlled field:

1. Open a new or existing bibliographic record in the MD Editor.
2. In an authority-controlled field, press F3 OR type at least three characters of the author’s name or subject heading for a new bibliographic record and then press F3 to display a list of suggestions.

3. Select one of the following buttons:
   - Select – Links the selected authority name or subject heading to your bibliographic record.

Note

Local authorities are indicated by (Local) to the right of the title. A star to the left of the title indicates the preferred term. With any selection, the preferred term immediately replaces the non-preferred term.

If you do not see the desired name or subject heading in the list, type additional characters in the field to narrow the results.
• **View** – Opens a read-only version of the full authority record on the right side of the split screen in the Authority tab. For authorized headings, clicking **View** opens the right side of the split screen, with the bib record(s), linked and unlinked, in one sub-tab, and the linked authority in the other tab. For unauthorized headings, clicking the **View** option displays the bibliographic record on the right side of the split screen.

  ▪ **Add record to editing list** – If the authority record that appears when you select **View** is local, not locked by another user, and not already included in the authority draft list, use this option to add it to your authority draft list. Select **Add record to editing list** to add the local authority record to your working records list. After the record was added to your working records list, you can edit this local authority record in the MD Editor.

  ▪ **Edit** – If the authority record that appears when you select **View** is local and not locked by another user, you can select **Edit** to modify the local authority record. Note that this capability is also available from Browse Bibliographic Headings (Resources > Cataloging > Browse Bibliographic Headings).

### Viewing Bibliographic Records Linked or Available for a Suggested Authority Record

When you use F3, bibliographic headings may be presented in addition to the authority headings. Note that the list of authority headings and **Headings from bibliographic records** that appear with using F3 originate from the Network Zone or the Institution Zone based on the scope of the record that you are editing. Use the procedure below to view the available bibliographic records.

**To view the bibliographic records that are linked or available for a suggested authority record:**

1. Open a new or existing bibliographic record in the MD Editor.
2. In an **authority-controlled field**, type at least three characters of the author’s name or subject heading for a new bibliographic record and then press F3 to display a list of suggestions or press F3 in the authority-controlled field.
3. Select the **View** button for one of the rows that appears in the authority records list. The right pane opens with the Authority and Bibliographic Records tabs.
4. Select the **Bibliographic Records** tab (in the right pane of the MD Editor).
5. Use the **Include** filter to select one of the following options:
° **Matching Headings** – Select to view all the possible available bibliographic headings that match the text of the authority heading that you selected to view in the left pane.

° **Linked Records** – Select to view only the linked bibliographic headings that are linked to the authority record that you selected to view in the left pane.

Note that in a Network Zone, when you use F3 (or the linking icon) from a Network Zone record, the bibliographic headings that appear on the Bibliographic Records tab are Network Zone records. When you use F3 from a local record, the bibliographic headings that appear on the Bibliographic Records tab are local records.

6. Select the **View** link from the Bibliographic Records tab for the bibliographic record that you want to see that is linked or available for the selected authority record. When you select the **View** link for a result, Alma displays a full, read-only bibliographic record.

---

### Deriving an Authority Record from a Bibliographic Record

You can create local authority records when there are no headings that match. There are cases in which a cataloger catalogs a bibliographic record with a headings field that cannot be linked to an existing authority record. For these cases, Alma provides the option to create a local authority record with the relevant content. This capability is provided for institutions that have the appropriate parameters set (by Ex Libris) for managing local authority records.

For more information, see the [Derive an Authority Record from a Heading in the Bibliographic Record](#) video (2:00 mins).

**To add authority records for headings with no match:**

1. Open a new or existing bibliographic record in the MD Editor.

2. In an **authority-controlled field**, enter headings information that you know does not exist in an authority record and press F3. The field appears in the normal manner with the addition of the **Create Authority Record** option.

3. Select **Create Authority Record**. The new authority record is created and displays in the MD Editor in the side-by-
Quick Authority Record Created

4. The list of authority records in the MD Editor also shows the new authority record that you created.

List of Authority Records in the MD Editor

Note

When you create authority records using Create Authority Record and the focus field when you press F3 is a non-preferred field such as the 600 field, the content is placed in the preferred field 100 in the new authority record that is created.

5. Complete processing the bibliographic record as you normally would.

Viewing Linked Names/Subject Headings from a Bibliographic Record

The MD Editor allows you to view linked names/subject headings quickly from an authority-controlled field.

To view a linked name/subject heading:

1. Open a bibliographic record in the MD Editor.

If an authority-controlled field is linked to a name/subject heading, an icon appears next to the field: the icon appears for full linking, and
appears for partial linking. Partial link is a link between a bibliographic heading with subdivision to an authority record without subdivision.

Linked-Field Icon

2. Select the icon to display the linked name/subject heading in split-screen mode.

View Name/Subject Heading in Split-Screen Mode

Using F3

F3 can be used to access authority headings from bibliographic records or authority records in the MD Editor. See Editing Bibliographic Records with F3 and Editing Authority Records with F3 for more information.

For the authority headings that are provided from the Community Zone when you use F3, you can copy these records to your institution’s local authority database or a Network Zone local authority database, if your institution is configured for local authorities. See Copying Community Zone Authority Records to Your Local Authority Database for more information.

For more information related to punctuation options when using F3, see add_punctuation_for_heading.

Normalization of special characters (such as ö, ñ, or å) when bibliographic headings search for matching authority headings is handled by a standard component of Java. See http://userguide.icu-project.org/transforms/general for more information.
Editing Bibliographic Records with F3

While creating and editing records in the MD Editor, F3 enables you to link to suggested authority records quickly from an authority-controlled field in a bibliographic record and to view a read-only version of a suggested authority record and view the bibliographic records that are linked to this authority record (see the procedure To view the bibliographic records that are linked to a suggested authority record for more information).

When you press F3 from an authority-controlled field in the MD Editor, the system presents a sorted, full list of browsable authority headings.

![F3 Sorted List of Authority Headings](image)

**Note**

If you are working in IE and press F3, make sure that you press Enter while the focus is on the text. Otherwise, the headings list may not display properly.

The system looks for a match to the contents of the authority-control field, highlights the match in yellow, and sorts the results in alphabetical order. The list starts with the two authority headings that precede the matched headings.

F3 presents a list of authority headings that match the whole bibliographic heading; and if it includes a subdivision, F3 presents a list of authority headings that match it. Note that the F3 process for matching is different from the matching process used in the Authorities - Link BIB Headings job. See Authorities - Link BIB Headings for more information.

If your system uses multiple authority vocabularies and is configured for multiple authority priorities (see Authority Priorities), the sorted, matched authority headings lists for each vocabulary are presented on separate tabs that appear in the priority order that you had Ex Libris configure. Select a different tab to view the different authority headings.
F3 Tabs for Multiple Authority Vocabularies/Priorities

If you find a match in one tab/vocabulary and switch to a different tab where there is no match, the system places an indicator showing where the match would occur in the list if a match existed.

Your Entry Would Be Here and Previous and Next Arrows

If you type additional text in the control field, select the magnifying glass icon or press Enter to refresh your authority headings list.

When you enter text in the control field, note that you are also modifying the text in that field that will continue to appear even after you press Cancel to return to the record in the Metadata Editor.

Control Field 100 - Original Version

Control Field 100 - F3 + Editing

Control Field 100 - Modified Text in the Record

For authority headings that are linked to the bibliographic field, a special icon in the authority headings list indicates that the link exists. This exists for all vocabularies.
Headings from Bibliographic Records Tab

In addition to one or more authority headings tabs, there is also the **Headings from bibliographic records** tab. Depending on the type of bibliographic control field from which you pressed F3, the **Headings from bibliographic records** tab presents a list of bibliographic names or subject headings.

When you press F3 from the control field of the bibliographic record that you are editing, the "Show authorized headings" checkbox allows you to see both authorized and non-authorized bibliographic headings, which allows you to view the full list of headings available:

- When the "Show authorized headings" checkbox is clear, then upon pressing F3 the Bibliographic Headings tab shows only unauthorized headings. Unauthorized headings appear in the list without an icon.
- When the checkbox is selected, all bibliographic headings are displayed for the vocabulary of the bibliographic field. If there are several vocabularies defined for the field, the list includes bibliographic headings linked to all of them. Authorized headings have the binocular icon next to them. This indicates which headings are authorized and the type of authorization.
Note that the heading of the currently edited record does not appear in this list - only headings from other bib records appear. If no match is found in **Headings from bibliographic records** when F3 is pressed, the list of results is presented with no indication of relative placement as with the authority vocabularies that indicate **Your entry would be here**.

The View and Select buttons in the authority headings list work as previously described on this page. See the [Viewing and Linking to an Authority Record](#) and [Viewing Bibliographic Records Linked or Available for a Suggested Authority Record](#) sections for more information.

For institutions working with multilingual authority records, when you select a bibliographic headings record (from the **Headings from bibliographic records tab**) that has no language or a different language specified in subfield 9 from the language in the record being edited, the content in subfield 9 of the bibliographic headings record overrides or replaces the values in the record being edited. See the following table for an example:

<table>
<thead>
<tr>
<th>$9 in the Record Being Edited</th>
<th>$9 in the Bibliographic Headings Record</th>
<th>Resulting $9 in the Record Being Edited</th>
</tr>
</thead>
<tbody>
<tr>
<td>lat</td>
<td>lat</td>
<td>lat</td>
</tr>
<tr>
<td>lat</td>
<td>none</td>
<td>lat removed</td>
</tr>
<tr>
<td>none</td>
<td>lat</td>
<td>lat</td>
</tr>
<tr>
<td>lat</td>
<td>cyr</td>
<td>cyr</td>
</tr>
</tbody>
</table>

### 751 Field

When you use F3 in the 751 field, names headings and subject headings are presented in the authority headings results. With this implementation of F3 for the 751 field, subject headings results are presented in addition to names headings results, when a second indicator is cataloged in the bibliographic record. If no second indicator is specified, only names headings results appear in the F3 results.

The 751 field can also be linked to names headings and subject headings depending on how you have cataloged the record.

[Linked 751 Field](#)
3XX Bibliographic Record Control Fields

Alma supports MARC 21 and KORMARC 3XX fields for use with the F3 functionality and enables linking these fields to authorities. If you want to use this capability, contact Support to configure this for you. Note that to fully implement this capability, recalculating the headings and reindexing is required. Otherwise, this change applies only to new and modified records.

The 3XX bibliographic control fields work in a similar manner to other bibliographic control fields. The vocabulary cataloged in $2 of the 3XX field determines the vocabulary that is presented in the authority headings list when you press F3. For example, when $2 is cataloged with lcsh, the LCSH tab (vocabulary) appears with the authority headings list results.

The table below lists the authority headings fields that are linked to by the 3XX bibliographic control fields.

<table>
<thead>
<tr>
<th>Bibliographic Tag</th>
<th>Authority Headings Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>380</td>
<td>155, 455</td>
</tr>
<tr>
<td>385</td>
<td>150, 450</td>
</tr>
<tr>
<td>386</td>
<td>155, 455</td>
</tr>
<tr>
<td>388</td>
<td>148, 448</td>
</tr>
</tbody>
</table>

When enabled, the 3XX bibliographic control fields are used for linking in the following workflows:

- F3 linking in the MD Editor
- Linking when saving or loading records
- Linking via the linking job

Editing Authority Records with F3

Note

There is a known issue where this feature does not work for the CNMARC vocabulary.

5XX Authority Record Control Fields

While creating and editing authority records in the MD Editor, F3 enables you to update the 5XX fields from the authority headings information (similar to using F3 with bibliographic records). The list of authority heading records presented are from the same vocabulary as the vocabulary of the record being cataloged. See the example below.
When the preferred term is copied to the 5XX field in the MD Editor, all subfields in the 5XX field are overridden, except for the numeric subfields. For vocabularies that use IDs such as (DE-588)1077656882, the ID of the selected authority record is added to the 5XX field. The ID is added to the following 5XX subfields:

- MARC 21 – Subfield 0
- UNIMARC – Subfield 3

For multilingual vocabularies, the preferred term matching the language of the selected headings record is copied to the 5XX field.

This capability is available for institutions working with local authority records or when editing authority records in the Community Zone.

For institutions in the Network Zone, the headings that are shown are compatible with the cataloged record. That is, Network Zone authority headings are displayed for Network Zone records; and Institution Zone authority headings are displayed for Institution Zone records. If a vocabulary is managed both locally (Institution Zone or Network Zone) and in the Community Zone, the headings list shows headings from both the local and Community Zone vocabularies (consistent with...
the behavior for bibliographic records).

With the focus on the 5XX field in the MD Editor, you can select View "See Also" ([Record Actions > See Also]) to show both records, the authority record being edited and the linked authority record. See View "See Also" for more information.

3XX Authority Record Control Fields

For MARC 21, the F3 capability in the MD Editor can be used from the 3XX authority record control fields as a cataloging aid to locate existing preferred terms. The 3XX authority record control fields shown in the table below can be used with F3 to locate preferred terms in the corresponding authority headings fields as identified in the table below.

<table>
<thead>
<tr>
<th>Authority Tag</th>
<th>Authority Headings Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>368</td>
<td>150, 450</td>
</tr>
<tr>
<td>370</td>
<td>151, 451</td>
</tr>
<tr>
<td>372</td>
<td>150, 155, 450, 455</td>
</tr>
<tr>
<td>373</td>
<td>110, 410</td>
</tr>
<tr>
<td>374</td>
<td>150, 450</td>
</tr>
</tbody>
</table>

When you press F3 for one of the 3XX authority record control fields that you are editing in the MD Editor, the headings list results for the same vocabulary appear. After you review the available preferred terms and Select a row from the list, the 3XX authority control field in the authority record is updated with the preferred term.

Copying Community Zone Authority Records to Your Local Authority Database

When editing bibliographic records in the MD Editor and using F3, the Community Zone authority record that appears in the right pane when you select View ([Viewing and Linking to an Authority Record]) can be copied to your institution's local authority database; or in the Network Zone, it can be copied to the Network Zone local authority database. This can be done by using the Copy or Copy to Network buttons that appear with the Community Zone authority record in the right pane.

The Copy button appears when your institution or Network Zone is configured for local authorities. Both the Copy and Copy to Network buttons appear for a Network Zone member institution where both the member institution and the Network Zone are configured for local authorities.
To Copy Community Zone Authority Records to Local Authority Database:

1. Select **Copy** (or **Copy to Network**). The **Authority Record Copy Cataloging** dialog box prompts you to select the vocabulary code and originating system for the authority record that you are copying.

![Authority Record Copy Cataloging](image)

2. Select **Continue**. The record that is copied to your local authority database opens in the right pane. When the record is copied, a 035 field with the originating system and the MMS ID of the Community Zone record is added to it. You can edit this record as you normally would and save it.

![Authority Record Copied to Local Authority Database](image)

Working with GND Records in the MD Editor

See the sections below for information regarding working with GND records in the MD Editor.

GND Bibliographic Control Fields Used with F3

When you browse GND authority headings using F3, the bibliographic control fields specified in the table below are used to identify what appears in the browsable list.

<table>
<thead>
<tr>
<th>Bibliographic Field</th>
<th>Authority Heading Type</th>
<th>Entity Type of the GND Authority Record Identified in the 075 $b</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Personal Name</td>
<td>n or p</td>
</tr>
<tr>
<td>110</td>
<td>Corporate Name</td>
<td>g or b</td>
</tr>
<tr>
<td>110</td>
<td>Geographic Name</td>
<td>g or b</td>
</tr>
<tr>
<td>111</td>
<td>Meeting Name</td>
<td>f</td>
</tr>
<tr>
<td>Bibliographic Field</td>
<td>Authority Heading Type</td>
<td>Entity Type of the GND Authority Record Identified in the 075 $b</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>130</td>
<td>Uniform Title</td>
<td>u</td>
</tr>
<tr>
<td>240</td>
<td>Personal Name</td>
<td>u</td>
</tr>
<tr>
<td>240</td>
<td>Corporate Name</td>
<td>u</td>
</tr>
<tr>
<td>240</td>
<td>Meeting Name</td>
<td>u</td>
</tr>
<tr>
<td>600</td>
<td>Personal Name</td>
<td>p or u</td>
</tr>
<tr>
<td>610</td>
<td>Corporate Name</td>
<td>u</td>
</tr>
<tr>
<td>611</td>
<td>Meeting Name</td>
<td>f or u</td>
</tr>
<tr>
<td>630</td>
<td>Uniform Title</td>
<td>u</td>
</tr>
<tr>
<td>650</td>
<td>Topical Term</td>
<td>s</td>
</tr>
<tr>
<td>651</td>
<td>Geographic Name</td>
<td>g</td>
</tr>
<tr>
<td>689</td>
<td>Any</td>
<td>All except n</td>
</tr>
<tr>
<td>700</td>
<td>Personal Name</td>
<td>n or p or u</td>
</tr>
<tr>
<td>710</td>
<td>Corporate Name</td>
<td>b or u</td>
</tr>
<tr>
<td>710</td>
<td>Geographic Name</td>
<td>g</td>
</tr>
<tr>
<td>711</td>
<td>Meeting Name</td>
<td>f or u</td>
</tr>
<tr>
<td>730</td>
<td>Uniform Title</td>
<td>u</td>
</tr>
<tr>
<td>751</td>
<td>Geographic Name</td>
<td>g</td>
</tr>
</tbody>
</table>

See [Using F3](#) for more information.

**GND Special Sorting Routine Used for Browsing Headings with F3**

When F3 is used to browse GND headings, Alma uses a special routine to build the sorted list that appears. The special sort routine includes the following characteristics:

- The text from the name and subject headings is used to build the string for sorting the headings browse list.
- Each subfield is treated as a separate sorting block.
- Under certain conditions, the 548 $a and the 550 $a are added to the string built for sorting the headings browse list.
- When building the filing value for GND records with the 548 and 550 fields, the 548 field is appended with a single space as a delimiter; and the 550 field is appended with three spaces as a delimiter.
- When there are repeatable occurrences of the 548 and 550 fields, the filing text concatenates all entries into a single component.

See the following example for a browsable headings list resulting from this special sort routine:
German Language Sorting Used with F3

When you are browsing authority headings records of German vocabularies using F3, special German language sorting is used for sorting the headings list. See Using F3 for more information.

See the German Characters for an explanation of sorting German language umlaut characters and so forth when German authority headings are sorted. This sorting method applies to GND, RVK, and BKL.

Implemented Punctuation Rules for Updated Bibliographic Records

The following punctuation rules are implemented when bibliographic records are updated from the authority database:

<table>
<thead>
<tr>
<th>(1) Tag &amp; Indicators</th>
<th>(2) Subfield to Which Punctuation Is Added</th>
<th>(3) Subfield Following the Subfield in Column (2)</th>
<th>(4) Punctuation to Be Added</th>
<th>(5) If Punctuation Exists/Does Not Exist Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>1########</td>
<td>a</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>1########</td>
<td>d</td>
<td>.</td>
<td>-.</td>
<td>-.</td>
</tr>
<tr>
<td>100##</td>
<td>a</td>
<td>4</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>100##</td>
<td>a</td>
<td>d</td>
<td>.</td>
<td>-. ),.</td>
</tr>
<tr>
<td>100##</td>
<td>a</td>
<td>e</td>
<td>.</td>
<td>-. ),.</td>
</tr>
<tr>
<td>100##</td>
<td>c</td>
<td>e</td>
<td>.</td>
<td>-. ),.</td>
</tr>
<tr>
<td>100##</td>
<td>q</td>
<td>e</td>
<td>.</td>
<td>-. ),.</td>
</tr>
<tr>
<td>100##</td>
<td>d</td>
<td>4</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>110##</td>
<td>b</td>
<td>.</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>(1) Tag &amp; Indicators</td>
<td>(2) Subfield to Which Punctuation Is Added</td>
<td>(3) Subfield Following the Subfield in Column (2)</td>
<td>(4) Punctuation to Be Added</td>
<td>(5) If Punctuation Exists/Does Not Exist Condition</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------</td>
<td>-----------------------------------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>110##</td>
<td>a</td>
<td>e</td>
<td>,</td>
<td>-),,.</td>
</tr>
<tr>
<td>110##</td>
<td>b</td>
<td>e</td>
<td>,</td>
<td>-),,.</td>
</tr>
<tr>
<td>600##</td>
<td>a</td>
<td></td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>600##</td>
<td>b</td>
<td>a</td>
<td>.</td>
<td></td>
</tr>
<tr>
<td>600##</td>
<td>d</td>
<td>a</td>
<td>.</td>
<td></td>
</tr>
<tr>
<td>600##</td>
<td>d</td>
<td></td>
<td>.</td>
<td>,,</td>
</tr>
<tr>
<td>600##</td>
<td>q</td>
<td></td>
<td>.</td>
<td>.),,.</td>
</tr>
<tr>
<td>600##</td>
<td>t</td>
<td></td>
<td>.</td>
<td>.),,.</td>
</tr>
<tr>
<td>6###</td>
<td>a</td>
<td></td>
<td>.</td>
<td>-),,.</td>
</tr>
<tr>
<td>6###</td>
<td>v</td>
<td></td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>6###</td>
<td>x</td>
<td></td>
<td>.</td>
<td>.),,.</td>
</tr>
<tr>
<td>6###</td>
<td>y</td>
<td></td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>6###</td>
<td>z</td>
<td></td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>7###</td>
<td>a</td>
<td></td>
<td>.</td>
<td>-),,.</td>
</tr>
<tr>
<td>7###</td>
<td>a</td>
<td>4</td>
<td>.</td>
<td></td>
</tr>
<tr>
<td>7###</td>
<td>a</td>
<td>e</td>
<td>.</td>
<td></td>
</tr>
<tr>
<td>7###</td>
<td>a</td>
<td>d</td>
<td>.</td>
<td>-),,.</td>
</tr>
<tr>
<td>7###</td>
<td>d</td>
<td>e</td>
<td>.</td>
<td>-),,.</td>
</tr>
<tr>
<td>7###</td>
<td>c</td>
<td>e</td>
<td>.</td>
<td>-),,.</td>
</tr>
<tr>
<td>7###</td>
<td>q</td>
<td>e</td>
<td>.</td>
<td></td>
</tr>
<tr>
<td>7###</td>
<td>b</td>
<td></td>
<td>.</td>
<td>,,</td>
</tr>
<tr>
<td>7###</td>
<td>b</td>
<td>e</td>
<td>.</td>
<td>,,</td>
</tr>
<tr>
<td>7###</td>
<td>d</td>
<td></td>
<td>.</td>
<td>,,</td>
</tr>
<tr>
<td>7###</td>
<td>d</td>
<td>t</td>
<td>.</td>
<td></td>
</tr>
<tr>
<td>800##</td>
<td>t</td>
<td>v</td>
<td>_; (space before semicolon)</td>
<td>;</td>
</tr>
<tr>
<td>810##</td>
<td>t</td>
<td>v</td>
<td>_;</td>
<td>;</td>
</tr>
<tr>
<td>811##</td>
<td>t</td>
<td>v</td>
<td>_;</td>
<td>;</td>
</tr>
<tr>
<td>(1) Tag &amp; Indicators</td>
<td>(2) Subfield to Which Punctuation Is Added</td>
<td>(3) Subfield Following the Subfield in Column (2)</td>
<td>(4) Punctuation to Be Added</td>
<td>(5) If Punctuation Exists/Does Not Exist Condition</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>83###</td>
<td>a</td>
<td>v</td>
<td>_,</td>
<td>;</td>
</tr>
<tr>
<td>8####</td>
<td>n</td>
<td>v</td>
<td>_,</td>
<td>;</td>
</tr>
<tr>
<td>8####</td>
<td>p</td>
<td>v</td>
<td>_,</td>
<td>;</td>
</tr>
<tr>
<td>8####</td>
<td>f</td>
<td>v</td>
<td>_,</td>
<td>;</td>
</tr>
<tr>
<td>8####</td>
<td>l</td>
<td>v</td>
<td>_,</td>
<td>;</td>
</tr>
<tr>
<td></td>
<td>s</td>
<td>v</td>
<td>_,</td>
<td>;</td>
</tr>
<tr>
<td>8####</td>
<td>x</td>
<td>v</td>
<td>_,</td>
<td>;</td>
</tr>
</tbody>
</table>

Column (1) = This column specifies the tag and indicators to which the rule applies.

Column (2) = This column identifies the subfield to which the punctuation may need to be added. If nothing is specified in Column (3), the subfield in column (2) is assumed to be the last subfield specified for the tag.

Column (3) = This column specifies the subfield that follows the subfield in column 2 when punctuation may need to be added.

Column (4) = This column identifies the punctuation that is to be added when the rule conditions are met.

Column (5) = This column is used to determine whether or not the punctuation in column (4) is added to the subfield identified in column (2). It provides the following rule conditions:

- If any of the punctuation specified in this column exists, the punctuation specified in column (4) is not added.
- If there is no punctuation specified in this column (the cell is blank), the punctuation in column (4) is added if all other conditions are met.

### Handling Deleted Authorities During Metadata Imports

Alma allows you to delete local authority records that have been marked for deletion (which is indicated by a d, s, or x in the fifth position of the record's LDR) during metadata imports. For example, the following record has the fifth position set to d:

![Record View](image)

Record Marked for Deletion
Working with the Norwegian Authority System (BARE) Records

Alma provides support for the Norwegian Authority System (BARE) authorities in the Community Zone and the ability for authorized contributing institutions to seamlessly submit approved authority records to the BARE database and the Alma Community Zone in an end-to-end workflow from directly within Alma.

Note

In order to contribute BARE authority records, your institution needs to be configured in the Community Zone by Ex Libris. Submit a Salesforce case to request Ex Libris to configure your authorization in the Community Zone.

BARE data has been added to the Community Zone, and Ex Libris has added and will maintain the list of BARE contributing institutions with permission to update the BARE database.

With this capability, you can create, update, or delete BARE authority records using the Alma MD Editor. When you save a new or updated record or delete a BARE record in the Alma MD Editor, a request is sent to BARE for approval (via SRU/U protocol). If an approved record response is returned, the record is saved in the Community Zone and the master BARE database. Otherwise, an error message is displayed to the user in the MD Editor, and whatever issue BARE has with the record will need to be resolved.

In the records sent to BARE for contribution, the 005 field is populated with the originating system version (instead of the date/timestamp). When the record is returned to Alma after contribution or when reloading the record from BARE, the originating system version is updated in the Alma record.

Changes accepted by BARE are incorporated into the master BARE database and become available to all Alma users through the Community Zone. There is a daily OAI import process that updates the Community Zone with ongoing changes of the BARE authority files. Ex Libris will regularly update the Community Zone with BARE changes to include those changes made outside the Alma environment.

Using the existing method (F3), MARC 21 bibliographic records can be created or edited in the Alma MD Editor using BARE authorities. Refer to the section Creating Bibliographic Records for more information.

For information regarding cataloging level assignment while working with records in the MD Editor, see Cataloging Externally Managed Authority Records for more information. For BARE records, the cataloging level value from the drop-down list in the MD Editor populates $a in the 901 field.

Contributing BARE Records

Use the following procedure for contributing (submitting) BARE records for approval.

To contribute/submit a BARE record for approval:

1. Open the MD Editor (Resources > Cataloging > Open Metadata Editor).
2. Select New > BARE to create a new record.
3. Enter the authority record details.

4. Select the Save icon.

Alma submits the record to BARE for approval. If there is an error, Alma displays an error message in a dialog box and asks if you want to reload the record from scratch or continue editing. Select Yes to reload the record and discard your changes or select No to return to the MD Editor and continue editing. If the contributed record is approved, it is stored in the Community Zone and the master BARE database.

Working with the Regensburger Verbundklassifikation (RVK) Authority Record Classification

You can create RVK authority records that contain call number headings in the 153 field. Subsequently, bibliographic records can be created in the MD Editor and F3 can be used while entering the bibliographic 084 field to perform a check against the authority 153 field for authority call number headings. See the RVK Search Indexes section on the Search Indexes page for more information regarding RVK.

Alma provides a default RVK template for creating RVK authority records. This template can be duplicated for you to modify, or you can create a new RVK template to match your template requirements.

To work with the Regensburger Classification System (RVK) template:

1. Open the MD Editor (Resources > Cataloging > Open Metadata Editor).

2. Select the Templates tab. The list of template folders appear.
3. Open the folder to work with the default RVK template provided. See Working with Record Templates for instructions.

To create an RVK local authority record:

1. Open the MD Editor (Resources > Cataloging > Open Metadata Editor).
2. Select New > RVK template.

Alma loads the RVK form in which you can enter the RVK local authority record.

3. Enter the data for your authority record.
4. Select File > Save and Release Record.

Using the repository search, you should be able to locate the RVK authority record with an Authorities search.
To perform an RVK 084 headings check for a bibliographic record:

1. Use a search to locate the bibliographic record with which you want to work, and select **Edit** to open the record in the MD Editor.
2. Select **Edit > Add Field** to add the 084 field.
3. Enter $2 with rvk.

4. When you enter $a, press **F3** to check for preferred terms. The system finds authority records based on the classification number (153 $a) or classification caption (153 $j). See [Classification Search Indexes](#) for more information.

See [Creating Bibliographic Records](#) for more information regarding using F3 when creating/editing bibliographic records.

### Using Originating System IDs for Linking Bibliographic Records to Authority Records

Alma provides support for using originating system IDs for linking bibliographic records to specific authority records. This capability can be used only if $0 exists in one of the authority-controlled data fields of your bibliographic records. If $0 exists, it can be used to store the originating system ID for the authority record (pulled from the authority record 035 $a) to which you want to link the current bibliographic record.

The default method in Alma for linking bibliographic records to authority records uses text matching only. If you want to use ID matching, contact Ex Libris to reconfigure your authority linking method.

Refer to the Authority-Controlled Data Fields Supported table below for a list of the authority-controlled data fields that are supported for ID matching capability.

<table>
<thead>
<tr>
<th>Authority-Controlled Data Fields Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>Parameter</td>
</tr>
</tbody>
</table>
Second indicator

The originating system is determined by the field’s second indicator as identified in the following list:

- 0=LCSH
- 1=LCSHKIDS
- 2=MESH
- 3=NAL
- 4
- 5=CSH
- 6=RVM
- 7=as defined in subfield 2. For example: 650 17$aCareer Exploration.$2ericd

Once a bibliographic record has $0 stored with the originating system ID for a specific authority record, the Alma daily process to update records will use the specific $0 information to update the authority linked bibliographic records.

To insert $0 with the originating system ID into a bibliographic record:

1. Open the bibliographic record to which you want to add $0 in the MD Editor.
2. Make the authority-controlled data field to which you want to add the $0 the active row and press F3. The headings from authority records are displayed.

F3 Authority Suggestions List
3. Select View for the authority record you prefer. The MD Editor displays the details of the authority record in Split Editor mode.

4. Review the authority record details, confirm that this is the authority record to which you want to link the bibliographic record, and select Select from the list of suggestions.

5. Save your bibliographic record. Now that this authority-controlled data field contains $0, pressing F3 displays only the authority record with the originating ID that is stored in $0.
Authority Control Based on Multiple Authority Identifiers in a Bibliographic Record

For institutions that require the ability to link bibliographic to authority headings using a direct ID that is not necessarily the originating system ID and with multiple system IDs specified, Alma provides support to accomplish this with the Direct ID Prefix in the Metadata Configuration (Configuration Menu > Cataloging section > Metadata Configuration).

For more information about configuring the Direct ID Prefix, see Adding a Local Authority Definition on this page.

Specifically, this is designed for bibliographic records with the linking record ID identified in $0 of the 650 field (see the illustration below) and the matching ID located in the 035 $a of the authority record (see the illustration below). This capability provides support for instances where the 650 field may contain more than one $0 where the intent is to specify linking system IDs for different systems.

Bibliographic Record with 650 $0

Authority Record with 035 Matching System ID to the Bibliographic 650 $0 ID Above

Based on the Direct ID Prefix that you specified in the Metadata Configuration, the system looks for an exact Direct ID Prefix match and then looks for an originating system ID match. In the above illustrations, the bibliographic record 650 $0 prefix/originating system ID, (DE-588)4017214-4, matches the authority record 035 $a (the second 035 entry).

When you are working with bibliographic records in the MD Editor and you enter 650 $0 with a valid Direct ID Prefix and record ID and select the Save icon, the system looks for an authority record that has a matching 035 $a. When a match is found, it displays a linking icon (to the left of the 650 record) indicating that it has linked to an authority record. Select the linking icon to open the authority record in the split screen.

When you are working with bibliographic records in the MD Editor, you can also press F3 from the active 650 field that has
no $0 specified, and the system presents any headings matches that it finds based on an exact Direct ID Prefix and originating system ID match or any prefix (such as DLC) and originating system ID match. From the authority headings list, View and/or Select a headings record.

View the Authority Headings Record

Select the Authority Headings Record

When you select a headings record, the matching authority record 035 $a value is copied to the bibliographic record’s 650 $0.
Authority Headings Record 035 $a Value Copied to 650 $0

See the illustrations below for a match on any prefix (such as DLC that is not identified as the **Direct ID Prefix** in the Metadata Configuration) and matching originating system ID.

![Image of MARC 035 and 650 fields]

650 Field with a Missing $0

![Image of an empty 650 field]

Matching 035 $a Using Any Prefix and a Matching Originating System ID

![Image of a 650 field with $a value and $0 value]

Matching Authority Record 035 $a Value Copied to the Bibliographic Record's 650 $0 When the Headings Record is Selected

If there is no 035 $a value, the system copies the standard record ID number to $0.

---

**Navigating from the Authority Record to the Linked Bibliographic Record**

For institutions configured to use ID matching for linking bibliographic records to authority records (instead of text matching)
as defined in a customer parameter managed by Ex Libris, the navigation from an authority record to the linked bibliographic record uses:

- Authority vocabulary and the linked originating system ID
- Direct IDs

When completing a repository search to find authority records (Community Zone or institution managed authority records), the search results display a list of authority records with the link **Search bibliographic records matching this value.**

![Search Bibliographic Records Matching This Value Link](image)

**Search Bibliographic Records Matching This Value Link**

When you select the **Search bibliographic records matching this value** link, the system can locate the specific, linked bibliographic record(s) using the authority vocabulary and the linked originating system ID or using a keyword search (default behavior) or direct ID (contact Customer Support to enable search by direct ID).

![Originating System ID Authority to Bibliographic Record Linking](image)

**Originating System ID Authority to Bibliographic Record Linking**

---

### Working with Multilingual Authority Records

Alma provides the capability for institutions to work with authority records that have preferred, non-preferred, and related terms in more than one language. This capability is described in the following sections:

- **Processing Preferred-Term Correction for Multilingual Records**
- **Subfield 9 with the Same Language Code**
- **No Subfield 9 Specified**
- **Display of Authority Search Results with Multiple Preferred Terms**
- **Preferred Term Correction for ID Linked Bibliographic Records with No Language Indication**

For more information, see the [Multilingual Authority Record Support video](https://www.exlibrisgroup.com/en-us/videos/multilingual-authority-record-support) (0:48 mins).

---

### Processing Preferred-Term Correction for Multilingual Records

For institutions whose bibliographic records contain $9 with an identifying language code, Alma’s multilingual capability has
been implemented as described below. For institutions with bibliographic records that may contain no identifying language code in $9, see the Adding a Local Authority Definition section and the Language Configuration explanation.

- The Multilingual parameter needs to be set to Yes for multilingual authority records. For local authority records, you need to specify this parameter in the Metadata Configuration. For Community Zone managed authority records, this setting needs to be configured by Ex Libris at the Community Zone level. For more information, see Multilingual in the table in the Adding a Local Authority Definition section.

- For MARC 21 records, the language code (such as lat, heb, ara, and so forth) for all preferred, non-preferred, and related terms is entered in $9.

- For UNIMARC records, the language code for all preferred, non-preferred, and related terms is entered in positions 5 and 6 of $7.

In a multilingual authority record, the preferred term is duplicated for each language. Non-preferred terms are entered as necessary for each language.
• When a non-preferred term is used in a bibliographic record, Alma updates the bibliographic record using the preferred term of the same language.

• When F3 is used (from the appropriate bibliographic fields) in the MD Editor to display a list of headings, the headings list is displayed as follows:
  ◦ If there is a language code (specified in the MARC 21 $9 or the UNIMARC $7) in the bibliographic record, only the headings that match the language appear.
  ◦ If there is no language code specified in the bibliographic record, all of the matching headings in all languages are displayed. The language code in the authority/bibliographic headings records is ignored.

• Validation of records is handled in the following manner:
  ◦ For authority records, Alma checks for the Multilingual setting. If the Multilingual setting is No, only one preferred field is allowed in the MARC 21 1XX or the UNIMARC 2XX. If the Multilingual setting is Yes and there is more than one preferred term, Alma checks for a language indication in the MARC 21 $9 or the UNIMARC $7, positions 5 and 6.
  ◦ For bibliographic records, validation of $9 has been enhanced to include $9 in the fields specified in the table below.

<table>
<thead>
<tr>
<th>MARC 21 Bibliographic Fields</th>
<th>KORMARC Bibliographic Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>084</td>
<td>084</td>
</tr>
<tr>
<td>382</td>
<td>100-199</td>
</tr>
<tr>
<td>440</td>
<td>382</td>
</tr>
<tr>
<td>490</td>
<td>440</td>
</tr>
<tr>
<td>648</td>
<td>490</td>
</tr>
<tr>
<td>650-651</td>
<td>600</td>
</tr>
<tr>
<td>654-655</td>
<td>610-619</td>
</tr>
<tr>
<td>748</td>
<td>630</td>
</tr>
<tr>
<td>751</td>
<td>648</td>
</tr>
<tr>
<td>810-819</td>
<td>650-651</td>
</tr>
<tr>
<td>830</td>
<td>654-655</td>
</tr>
<tr>
<td></td>
<td>700</td>
</tr>
</tbody>
</table>
Publishing to Primo enriches the bibliographic records with the preferred, non-preferred, and related terms of all languages.

Handling of Multiple Preferred Terms with the Same Language

When you are doing preferred-term correction from the MD Editor using F3 in an authority controlled field of a bibliographic record, and you select a non-preferred term, the system checks for a preferred term to link to; if it finds multiple preferred terms with the same language, the system prompts you to select which preferred term to use. See the example below.

Preferred-Term Selection Prompt

After selecting the preferred term, the system updates the bibliographic record in the MD Editor with the preferred term that you selected and identifies it with the binoculars icon indicating that the field is showing the preferred term for that authority controlled field.
Subfield 9 with the Same Language Code

With the appropriate configuration, Alma enables saving a multilingual authority that has multiple preferred terms with the same language code in subfield 9 without a validation warning or block. See Allow multi preferred terms for more information.

Multilingual Local Authority Record Configuration

When the Authorities – Preferred Term Correction job is run and it finds multiple preferred terms with the same language code in subfield 9, the bibliographic record is not corrected and the following message is reported in the Authority Control Task List:

Preferred Term Correction – Multiple preferred terms with the same language found

For these records, use the Authority Control Task List (see Using the Authority Control Task List) and make the changes manually. Use the Preferred Term Correction – Multiple preferred terms with the same language found Action option in the Authority Control Task List to locate these tasks.

No Subfield 9 Specified

Authority records with no $9 can be processed in Alma. Specific validation and preferred-term correction processes have been implemented to handle these cases. See Validation with No Subfield 9 and Preferred-Term Correction with No
Validation with No Subfield 9

With the appropriate configuration, Alma enables saving a multilingual authority that has no $9 without a validation warning or block when using the MARC 21 Auth validation on save process. See Allow multi preferred terms for more information.

Preferred-Term Correction with No Subfield 9

If a field in a bibliographic record is linked to a non-preferred term that has no subfield 9, the system attempts to identify a preferred term with no subfield 9 and uses that preferred term to correct the bibliographic record. If no such preferred term is found, the bibliographic record is not corrected; and it is reported in the Authority Control Task List (see Using the Authority Control Task List). See the example below in green.

Preferred-Term Correction Process with No $9

Display of Authority Search Results with Multiple Preferred Terms

When there is more than one preferred term in an authority record, each preferred term appears in the Authorities search results. See below for an example.

Multiple Preferred Terms Appear in Authorities Search Results
Preferred Term Correction for ID Linked Bibliographic Records with No Language Indication

When bibliographic record linking (to authority records) is done by ID, preferred term correction is completed for cases where there is no language indication in the bibliographic record and multiple preferred term options exist due to multilingual differences. As part of the preferred term correction process, the language indication in addition to the preferred term is copied to the bibliographic record. For MARC 21, the language indication is copied to $9; and for UNIMARC, it is copied to $7 positions 0-1.

Updating the Authority Record ID Automatically in Bibliographic Records

For institutions configured for ID-based authority control and that have implemented a Direct ID Prefix in their metadata configuration, Alma automatically updates the bibliographic records with the new authority record ID (replacing the old ID) in $0 for authority controlled headings fields when a new authority record replaces an existing authority record. This is true for both local and Community Zone authority records.

This capability incorporates automatic relinking of the bibliographic record to the new proper authority record and performs preferred term correction based on the new authority record. In addition, the Authority Control Task List provides a report to identify these ID changes.

Processing Automatic ID Changes

The handling of automatic authority record ID changes in bibliographic records is processed in the following manner:

1. New authority records with authority record ID changes are loaded into the Community Zone. The new authority records that are replacing existing authority records in the Community Zone have the new authority record ID stored in the 035 $a, and the previous authority record ID is stored in the 035 $z.

   There may be more than one previous record ID and, therefore, multiple 035 $z entries in a single authority record. In the example below, the (DE-588) entries are highlighted because (DE-588) is identified as the Direct ID Prefix in the Metadata Configuration List.

   

   **New Authority Record ID in the 035 $a**

2. The following scheduled jobs update the bibliographic records:

   - [Synchronize Changes from CZ](#) (and/or [Authorities – Handle Local Authority Record Updates](#) for local authority records)

     The Synchronize Changes from CZ job updates $0 in the bibliographic record and performs relinking to the authority record in the Community Zone.

     The Authorities – Handle Local Authority Record Updates job updates $0 in the bibliographic record and performs relinking for local authority records.

   - [Authorities – Preferred Term Correction](#)

     The Authorities – Preferred Term Correction job updates the bibliographic records with the new preferred terms based on the new authority record for both Community Zone linked records and local authority-linked records (when local authorities have been implemented).
See the Viewing Scheduled Jobs page for more information.

3. Changes are identified in the Authority Control Task List. See Reporting in the Authority Control Task List (below) for more information.

---

### Reporting in the Authority Control Task List

The Linking – BIB heading link changed due to AUT record redirection report type in the Authority Control Task List provides the details regarding changes made to bibliographic records when new authority records replace existing authority records. With this report type, there is a Comments column that provides the following information:

- Old authority record ID pulled from the authority record's 035 $z
- New authority record ID pulled from the authority record's 035 $a

See Using the Authority Control Task List for more information.

---

### Cataloging Externally Managed Authority Records

While editing authority records in the MD Editor for externally managed systems such as GND (see Working with GND Records in the MD Editor) or BARE (see Working with the Norwegian Authority System (BARE) Records), Alma provides the following capabilities to improve your workflow efficiency:

- Assignment of cataloging levels (see Assigning Cataloging Levels Upon Save)
- Cataloging level user preferences (see cataloging_level_user_preferences)
- Automatic record version check (see Checking Record Version Automatically)

---

### Assigning Cataloging Levels Upon Save

When you have cataloging levels configured for your institution (see Configuring Cataloging Levels for Contribution to Externally Managed Authorities), the Cataloger Level dropdown appears in the MD Editor above the authority record being cataloged.

When you save and contribute the record, the level you select in this dropdown populates the "Cataloging Permission Level" field in the authority record.

The values in this dropdown are inherited from the "External System Cataloging Level" column of your Cataloger Level to
Vocabulary Code mapping table (see Configuring Cataloging Levels for Contribution to Externally Managed Authorities) and the cataloger level assigned to the user in User Details.

Cataloger Level Defined in User Details

Depending on the cataloging preferences that you have set, the cataloging level that you select in the Cataloger Permission Level dropdown may continue to appear as the default for subsequent authority records that you edit. See Setting Cataloging Level User Preferences for more information.

Checking Record Version Automatically

In order to prevent a record from being rejected by an externally managed system because it is an older version, Alma checks with that system to determine if the record that you are opening in the MD Editor is newer or older than the one in the externally managed system. The version of the record that is stored in the 005 field is used for the version check. If the externally managed system contains a newer version of the record, Alma presents the option to reload the newer version before opening any record to edit. Select Yes to reload the newer version and proceed with editing the newer version, or select No to open and work with the older version of the authority record.

Extending Authority Fields to be Used for Authorized Bibliographic Field

New for January! When catalogers press F3 on one of the authority-enabled fields in the Metadata Editor, a list of headings coming from the relevant authority field appears. This functionality can be extended, so that pressing F3 displays the list of headings from several authority fields. Catalogers can then select any of the terms in the list, and have the preferred one copied to the bibliographic record.

For example: Pressing F3 on MARC field 650 with the second indicator ‘7’ for vocabulary DBN displays a list of headings from either 150/450 or 155/455 fields. This is done by combining the authority headings from all 150, 450, 155, and 455 fields into one list.
This functionality fully supports authority control:

- Linking to global and local authorities
- All bibliographic record formats
- Preferred Term Correction (PTC) job – The preferred term is copied from the Authority record to the Bibliographic record
- Authority enrichment in general publishing and publishing to Primo
- Search by Non preferred terms in Alma and in Primo VE

Note

Authority fields 180,181,182,185 are not supported by this functionality, as they are not part of the authority control mechanism.

Note

To set up this functionality for your institution, please contact Ex Libris Customer Support.